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License Agreement, Warranties and Limitations

MacDose is copyright by the University of Minnesota and is distributed as shareware. You may distribute it without charge
provided that you do not change it and you include the documentation.

MacDose is designed for teaching concepts of radiological physics. It is not accurate enough to be used for calculations of
dose or buildup factors.

The University of Minnesota makes no representations or warranties, express or implied. By way of example, but not
limitation, the University makes no representations or warranties of merchantability or fitness for any particular purpose of
the program or documentation nor that the program or documentation shall be free of all defects. The program and
documentation are supplied “as is.” The University of Minnesota shall not be held liable for any liability nor for any indirect
or consequential damages resulting from the use of the program or documentation.

The User’s Manual and Exercises for MacDose and the Instructor’s Guide are Copyright by Russell K. Hobbie.  A user may
reproduce them for teaching purposes provided they are not resold and this copyright notice is included in all copies that are
made.

Changes in Version 2.2

New Features

There is an option to show only the electrons.  This makes it easier to see how electron distributions change with energy or
when secondary photons interact.

An option has been added to draw tracks at twice normal thickness.  This makes them easier to see when projecting the
screen on television or using MacDose in a large room.

The windows now open to the full size of the Macintosh on which they are being used. This also helps when a large screen
Macintosh is being used in a classroom.  If the screen is larger than a small Mac (Plus, SE or Classic), a strip is left on the
right so that disk icons are not covered.  The large screen is automatically scaled to fit the printed page when results are
printed.  (Printing now requires two pages.)

MacDose runs properly in the background under System 7.0.

The option to Make All Photons Interact has been removed.

Bug Corrections

The Random Seed can now be set properly in Set Parameters.

Color Icons have been added for machines that can use them.

The Log File could corrupt the icons for an application that was used to open it.  This has been corrected.
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Introduction

MacDose is a computer simulation program designed to help you learn how photons interact in matter. An important quantity
in radiological physics is the dose, the average amount of energy absorbed per unit mass in tissue. Since the interactions of
photons in tissue are statistical in nature, the energy absorbed per unit mass is never exactly equal to the dose, but fluctuates
around it. MacDose allows you to shine a beam of photons on a sample of water, which interacts with radiation in much the
same way as the soft tissues in the body. You can vary the size of the sample and the energy of the photon beam. Some of the
simulations you can do show

• the statistical nature of the photon attenuation

• the relative importance at different energies of the three primary interaction processes (photoelectric effect, Comp-
ton scattering and pair production)

• the statistical nature of energy transfer and energy absorption

• the distinction between energy transfer and energy absorption

• the effect on absorbed dose of the interaction of subsequent photons

MacDose allows you to keep a Log File of the results of the simulation. The file can be read by a spreadsheet or a statistical
analysis program to reduce some of the labor of analyzing the simulations.

There are three windows. Each can be moved, resized, zoomed, and scrolled in the standard Macintosh fashion. One is for the
Simulation, one is for numerical Results, and one is for Graphs of Energy Transferred and Energy Absorbed. You can make a
copy of the Simulation, Results, and Graph windows at any time on your printer. This is useful for examining the numbers or
tracing the paths of the photons. You can also copy the Simulation window or the Graph window to the Clipboard and from
there to the Scrapbook or another application.

MacDose runs on a Macintosh Plus or later machine. If a color monitor is used, the incident photons are black, electrons are
red, and scattered photons are blue. The simulations can be printed in color on a color printer such as an Imagewriter-II
printer with four-color ribbon, even if the Macintosh has a monochrome display. MacDose is compatible with Multifinder
and System 7  and runs successfully in the background.

Typical execution speeds for 100 keV photons are 180 photons per minute on a Macintosh Plus or SE, and 850 photons per
minute on a Macintosh II or SE/30.

References
Many books discuss the physics of photon interactions in matter.  A few of them are listed here.

Anderson, D. W.  Absorption of Ionizing Radiation.  Baltimore, University Park Press, 1984.

Attix, H.  Introduction to Radiological Physics and Radiation Dosimetry.  New York, Wiley-Interscience, 1986.

Hobbie, R. K. Intermediate Physics for Medicine and Biology, 2nd. ed.  New York, Wiley, 1988.

Johns, H. E. and Cunningham, J. R. The Physics of Diagnostic Radiology, 4th ed.  Springfield, IL, Charles C. Thomas, 1983.
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How to Use MacDose

MacDose can be opened in the usual fashion by selecting the icon and pulling down Open from the File menu, or by double-
clicking on the icon. MacDose works with Multifinder.

The Simulation Window is shown below. It is shown here after a run has been completed.

Figure 1. The screen on a small-screen Macintosh after MacDose has been run. The Simulation window is at the
top. The Results window can be seen at the bottom. The Graph of Energy Transferred and Energy Absorbed win-
dow is hidden from view. The small icon in the upper right corner appears when operating under MultiFinder.
Each window has a zoom box in the upper right hand corner and a grow box in the lower right hand corner.

There are five menus: the Apple Menu, File, Edit , Program, and Windows.

The Apple Menu

The Apple menu is standard. It provides a brief message through About MacDose... and access to all the desk accessories
which are installed on your System disk.
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The File Menu

The File Menu has five entries.

Page Setup

Page Setup invokes the standard Dialog Box for page setup. MacDose will print on whatever printer has been
selected with the Chooser desk accessory.

Print Current Results

Print  Current  Results prints the contents of the Simulation, Graph of Energy Transferred and Energy Absorbed
windows on the first page, and the Results window on the second page.. The entire window is printed, regardless of
how the window appears on the screen.  It is scaled to fit the paper.

Start Log File

Start Log File asks for the name of a file and then creates it on the disk selected. Every time the Results window is
updated, the results are written to the Log File.

The Log File prints a header containing the following information:

The date and time of the simulation
The incident photon energy
The length of the sample along the beam
The thickness of the sample perpendicular to the screen
Whether or not interactions of secondary photons are considered

Then, for every 25 photons that strike the sample, it contains:

The number of photons that have struck the sample
The fraction that did not interact in the sample
The energy transferred to electrons
The energy absorbed in the sample
The ratio of energy absorbed to energy transferred
The energy absorbed per unit mass of the sample
The entrance collision kerma
The average collision kerma
The ratio of energy absorbed per unit mass to average collision kerma

When the Log File is closed, the following information is written to it for each of the ten slices perpendicular to the
beam:

The position x of mid-slice
The value of µx
The total energy transferred to electrons in the slice
The energy transferred to electrons in the slice by primary radiation
The ratio B = (total energy transferred)/(energy transferred by primary radiation)
The total energy absorbed in the slice

Since the energy and sample size are written as a heading in the Log File, you cannot change parameters while the
Log File is open.
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Close Log File

Close Log File closes the Log File which is currently open. It also writes at the end of the Log File the energy
transferred to electrons and the energy absorbed in each of ten slices of the sample.

Quit MacDose  Command-Q

Quit MacDose allows you to leave MacDose and return to the Finder.



MacDose 2.1  5

The Edit Menu

Can’t Undo     Command-Z

Since you do not do any editing in MacDose, the Undo feature is not implemented in MacDose. It is provided in the
menu in case you use a Desk Accessory which requires it.

Cut Command-K

Since you do not do any editing, Cut  is not implemented in MacDose. It is provided in case a Desk Accessory
requires it. For example, it is available when the Scrapbook is open.

Copy  Command-C

You may want to use results from a MacDose simulation in another program. Numerical results from the Results
window can be written to the Log File and read as text by another application. Pictorial results, such as the contents
of the Simulation window or the Graph of Energy vs. Depth window, can be copied when that window is active.
They can then be Pasted in the Scrapbook or, if you are using Multifinder, pasted directly in another application.

Paste Command-V

Since you do not do any editing in MacDose, Paste is not not needed. Once you have copied something to the Clip-
board, you can use Paste in another application. For example, you can Paste to the Scrapbook.

Clear

Clear is not needed in MacDose. It is provided for use with a Desk Accessory such as the Scrapbook.
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The Program Menu

The Program Menu has five entries:

Run a Given Number of Photons  Command-G

When you select Run a Given Number of Photons, the program will run until a certain number of photons have
struck the sample. The number is initially set at 1000. There are 25 photons per screen. Each time 25 photons strike
the sample the numbers in the results window are updated. The maximum number can be changed in the Set
Parameters menu.

If you are saving results to a Log File, the results will be cumulative, ie, for 25, 50, 75, 100, ... etc., photons.

You can also set the number of photons to a small number, 1, 3, or 5 photons, for example, to view the photon in-
teractions in a less cluttered environment. This is particularly useful if you are studying secondary interactions.

Run One Screen  Command-1

This runs a single screen of 25 photons. If it is selected again, these results will be cleared and another 25 photons
will strike the sample. If you are saving results to a Log File, each line will represent the effect of 25 independent
photons striking the sample.

Halt the Run  Command-H

Halt the Run terminates the simulation run. The results when the simulation is stopped are shown in the Results
window.

Resume the Run  Command-R

Resume the Run allows you to continue a run that you stopped. The Simulation window is cleared; the numbers in
the Results window are retained and the new results are added to them.
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Set Parameters  Command-E

Set Parameters opens a dialog box which allows you to change the photon energy, the length of the sample along
the beam, the thickness of the sample perpendicular to the screen, the seed for the random number generator, and the
maximum number of photons in a continuous run. A number like 1.00 E5 stands for 1.00 x 105.

Figure 2. The Set Parameters Dialog Box.

The height of the sample is calculated from the length along the beam to maintain the same aspect ratio (height-to-
length ratio) for the sample that you see on the screen. The thickness of the sample perpendicular to the screen can
be set independently. Its value does not affect the simulation; however, it determines the area perpendicular to the
beam and hence the photon fluence (photons per unit area), as well as the volume and mass of the sample.

Three check boxes are provided. When the first is checked, only the electrons are shown.
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E =  1.00e+5 eV Length =  1.00e-1 m

When the second box is checked, the photon and electron tracks are drawn at twice normal thickness.

E =  1.00e+5 eV Length =  1.00e-1 m

When the third box is checked, photons which are produced in an interaction can themselves interact. This can make
a very significant difference in the dose.
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The Windows Menu

The Windows menu allows you to bring any one of the three windows to the front of the screen. There are three windows, all
of which can be moved, resized, and scrolled:

Simulation

The Simulation window shows the incident and secondary photons and electrons. A typical simulation window is
shown below. Electrons are responsible for tissue damage, and electron tracks are double thickness. On a color dis-
play or color printer the scattered photons are blue and the electrons are red. In the window shown below the
electron tracks are very short.

Figure 3. The Simulation Window.

Scattered photons or electrons may leave through the top or bottom of the tissue sample. In the simulation below, the
arrow indicates a scattered photon which left through the bottom of the sample. The simulation makes the
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Figure 4. Simulation of Figure 3 repeated, with an arrow and dotted line added to show a photon which
has left the sample at the bottom and re-entered at the top.
photon enter again through the top. It continues in the same direction until it interacts. A dotted line has been added
to connect the point where the photon left with the point where it re-entered. Having the photons re-enter is
equivalent to running the simulation with a sample and photon beam of infinite extent vertically.

Results

The Results Window shows numerical results of the simulation. The results are updated every time a screen of 25
photons is completed or the simulation is stopped.

Figure 5. The upper portion of the Results Window.
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Graph of Energy Transferred and Absorbed

The graph of energy transferred to electrons and energy absorbed in each of ten slices is plotted each time a screen
of 25 photons is completed. This window is initially hidden behind the others.  It can be brought to the front by
moving one of the other windows and then clicking in it, or by selecting it in this menu.

Figure 6. The Graph of Energy Transferred and Absorbed window.
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Simulating the Physics

Random Numbers

The simulation in MacDose is based on a series of “random” numbers generated by the computer. These are actually a se-
quence of pseudo-random numbers, generated by a mathematical algorithm. One starts with a number called the “seed.” Each
calculation of a pseudo-random number in the sequence also generates the seed for the next calculation. If one starts with the
same seed, the same sequence of pseudo-random numbers is generated. With a different seed one gets a different sequence.
The initial seed used in MacDose is the number 2. The seed can be changed in the Set Parameters dialog.

Photon Interactions

Three types of photon interactions are simulated: the photoelectric effect, Compton scattering, and pair production. In the
photoelectric effect, the photon is absorbed by an atom and an electron emerges. Using an (in, out) notation, this can be called
a (γ, e) reaction. Compton scattering is a (γ,γ’e) reaction: a photon is incident and both a photon and electron emerge. Pair
production is a (γ,e+e-) reaction. The program ignores coherent scattering, which is a (γ,γ) reaction, since coherent scattering
does not produce any ionizing electrons and hence does not contribute to the dose. Coherent scattering occurs at energies
where the photoelectric effect is important.

The simulation of Compton scattering is reasonably accurate. The Compton cross section, multiplied by solid angle 2π sin θ
∆θ for scattering into the cone (θ, ∆θ), is divided by the total Compton cross section and compared to a random number in the
range (0, 1) to determine which of 24 angular bins contains the scattered photon.

Photoelectric effect and pair production simulations are less accurate. All photoelectrons are emitted in the forward direction.
This gives an inaccurate simulation when the length of the sample along the beam is comparable to the range of the
photoelectron.

For the pair production simulation, the positron is assumed to have kinetic energy distributed randomly and uniformly be-
tween 0.3E and 0.8E, where E is the sum of the kinetic energies of the electron and positron, E = hν - 2mec2. Electrons all are
assumed to travel in straight lines whose length is equal to the range calculated in the Continuous-Slowing-Down-
Approximation.

Subsequent Interactions

MacDose allows you to simulate subsequent interactions of photons that are produced in the interactions. These can make a
very significant contribution to the total dose. The program has been written so that the primary interactions use the same
sequence of random numbers whether or not subsequent interactions are being considered. Thus, if you make two runs, one
with and one without subsequent interactions, and you remember to start with the same random number seed, the pattern of
primary interactions will be the same. This feature makes it much easier for you to investigate the effects of subsequent
interactions.  Since all scattering takes place in the plane of the display, the energy transfer and energy absorption due to
subsequent interactions are only approximate.
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Exercises

Exercise 1. The kinds of photon interactions

This exercise introduces you to the three fundamental kinds of photon interactions: the photoelectric effect, Compton scatter-
ing, and pair production. You will discover that each dominates in a particular energy range. (Coherent scattering is not in-
cluded in the simulation, since it does not contribute to the dose.)

Photon tracks are drawn as narrow lines; electron tracks are thicker. On a color monitor or printer, the electron tracks are red.
In the photoelectric effect, the photon track stops. An electron track emerges, but unless the sample is microscopic in
dimensions, the electron moves such a short distance that its track is not seen. In Compton scattering, a scattered photon
emerges at some angle. For small values of length along the beam, the recoil electrons can be seen. In pair production two
thick tracks emerge, one for the electron and one for the positron.

The program is initially set to simulate 100 keV (1.00 E5 eV) photons. Run two or three times at this energy, one screen at a
time. Print each screen after you have run it, using Print Current Results. Identify photoelectric and Compton interactions.
Estimate the fraction of the interactions of each kind.

Repeat the same process for 20-keV (2.00 E4) and 10-MeV (1.00 E7) photons. Note how the fraction of interactions of each
kind changes with energy. You can change the energy with Set Parameters in the Program menu.
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Exercise 2. The statistical nature of photon interactions.

You can explore the statistical nature of the photon interactions. Different screens look different. You can explore quantita-
tively the fluctuations in the number of photons emerging from the sample unattenuated.

Set the energy at 250 keV. Run One Screen 10 times and tabulate the fraction unattenuated. Plot a histogram of the fraction
unattenuated, and calculate the mean and the standard deviation. (If you have access to statistical software, you could open a
Log File to record these results. However, each run must be done using Run One Screen, so that the results are reset and
each individual run is shown in the Log File.)

Turn on the Log File (or open a different one, if you had one open for the preceding task). Run 1000 photons (Run a Given
Number of Photons with the default value.) What is the fraction unattenuated? Use the Log File to plot the fraction
attenuated vs. the number of photons in the simulation. Note that the fraction unattenuated fluctuates about the average value,
and that the size of the fluctuations decreases as the number of photons in the simulation increases.

The Results window shows the value of the attenuation coefficient. How does e-µL compare to the average fraction unattenu-
ated for the ten runs (250 photons)? To the value for 1000 photons?

Vary the thickness of the sample (length along the beam). Plot the fraction unattenuated vs. thickness.
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Exercise 3. The difference between energy transferred and energy absorbed.

Set the energy at 60 keV. Use the default 0.1-m thick sample. Run one screen and record the Energy Transferred to electrons
and the Energy Absorbed in the sample. Are they the same?

Run one screen again. Are the numbers the same as the previous set? Why or why not? Are they the same as each other? Why
or why not?

Repeat this for two single-screen runs with 2 MeV photons and the same sample thickness. Explain what you observe now.

Using some long runs (1000 - 10,000 photons, depending on the time you have available), study the ratio of Energy Absorbed
to Energy Transferred for a 0.1 m sample at 100 keV, 300 keV, 1 MeV, 3 MeV, and 10 MeV.
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Exercise 4. The energy absorbed per unit mass for a thin sample.

Using 100 keV photons on a 1-mm thick target (1.00 E-3 m), turn on the Log File and record the energy absorbed in the
target vs. the number of photons which strike. Run for 10,000 incident photons. How does energy absorbed depend on
number of photons? Are there statistical fluctuations?
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Exercise 5. The difference between entrance collision kerma and average collision
kerma.

Using 60-keV photons and a 1-mm thick sample, compare the Energy Absorbed per unit mass to the Average Collision
Kerma.  Use 4,000 photons and plot the results vs. number of photons with the aid of the Log File.  Can you explain the
nature of the graph?

Then do a continuous run of 1000 photons at 60 keV with a 0.1-m thick sample. Notice from the Results Window that the
entrance collision kerma is 7.94 x 10-12 J kg-1 while the average collision kerma is only 3.44 x 10-12 J kg-1. Can you explain
the difference by looking at the simulation?



MacDose 2.1 19

Exercise 6. Study of plots of energy absorbed and energy transferred vs. depth in the
sample.

The energy transferred to electrons in a slice at a given depth in the sample will not be the same as the energy absorbed in
that slice, unless the range of the electrons is small compared to the thickness of the slice.

Refer to your work from Exercise 3 and consider the ratio of energy absorbed to energy transferred. At 100 keV you will find
that they are the same. Repeat your simulation for 10 MeV photons in samples of thickness 1 m, 0.2 m and 0.1 m. How do
energy transferred and energy absorbed compare vs. depth?

Repeat the simulation for 2 MeV photons and a sample 2 cm thick. Use 10000 photons. The range of a 1-MeV electron is
0.44 cm. Do you think you will see a buildup region?

Run with 50 keV photons in a 20-cm thick sample. Do you expect to be able to see any difference between energy transferred
and energy absorbed?
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Exercise 7. The effect of subsequent interactions.

Analytic calculations of energy transferred usually ignore the interactions of subsequent photons. Usually these are Compton
scattered photons, though they may also be fluorescence or annihilation radiation. An option in the Set Parameters dialog
box allows you to follow subsequent photons until there are no further interactions in the sample.  Since all scattering takes
place in the plane of the display, the numerical results for energy transferred and energy absorbed are only approximate.

The simulation in MacDose is based on a series of “random” numbers generated by the computer. These are actually a se-
quence of pseudo-random numbers, generated by a mathematical algorithm. One starts with a number called the “seed.” Each
calculation of a number in the sequence also generates the seed for the next calculation. Thus, with the same initial seed, you
will get exactly the same result. A different seed will allow you to see the effects of random fluctuations. The initial seed used
in MacDose is the number 2.

Use Set Parameters to make sure the random number seed is 2. Run a single screen. Print the result. Reset the seed to 2 and
run again. The results should be exactly the same.

The program has been written so that the primary interactions use the same sequence of random numbers whether or not sub-
sequent interactions are being considered. Thus, if you make two runs, one with and one without subsequent interactions, and
you remember to start with the same random number seed, the pattern of primary interactions will be the same.

Use Set Parameters to set the number of photons per run to 4. Make a series of runs at 100 keV, 1 MeV and 10 MeV with 4
photons each. Run first without subsequent interactions included, and then with subsequent interactions included. Each time
reset the seed to 2. Print your results. Compare the simulations. What is the total energy transferred to electrons in each case?
How many additional interactions are there for each incident photon? For the 10 MeV run, which heavy tracks represent
electrons? Which are positrons?
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Exercise 8. Energy transfer vs. depth with subsequent interactions.

Use 100 keV photons. Run for at least 1000 primary photons. Print the results. Repeat the run with a different random num-
ber seed. Plot the buildup factor, B, which is the total energy transferred to electrons in each slice with subsequent
interactions divided by the energy transferred by primary interactions. Since all scattering takes place in the plane of the
display, the numerical results for energy transferred and energy absorbed are only approximate.  Compare your plots to a
calculation based on Kc = Ψ (µen/ρ)? (You must include appropriate attenuation.) What is the buildup factor at the surface?
Why is it not unity?
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Exercise 9. The effect of subsequent interactions vs. photon energy.

Run for 1000 photons at 10 keV through 5 MeV, with subsequent interactions considered. Use a sample thickness such that
µL is about 5. How does the buildup factor for the first slice change with energy? Why?
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